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dntroducing Widget Workshop
What Is Widget Workshop, Anyway?

Widget Workshop is your very own mad scientist’s laboratory. It's a special
place inside your computer that you can go to play with all sorts of parts and
pieces and hook them all together to see what happens.

What's a Widget?

A widget is anything you build in your Widget Workshop! Widgets can be puz-
zles, experiments, silly machines, strange inventions or anything else you can
think of. There are hundreds of parts and pieces in the workshop—you can

build millions of different Widgets.

What Can I Do
With Widget Workshop?

You can solve the pre-built Widget puzzles—and make up your own puzzles to
stump your friends. You can create Widgets to carry out experiments to solve
science problems. You can create your own weird and wondrous Widgets that
do almost anything (or nothing at all)! You can just play with science and
have fun.

And you can save your Widgets in a special way so they will run on your
friends’ and your school’s computers—even if they don’t have Widget
Workshop.
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Mey! Wait a Minute!

Fun With Science???

That's right! Widget Workshop lets you have fun playing with science. We've
all heard people say that science is too hard—or just plain boring. But those
people are wrong! They just don't know what science is really about.

Science is about all these things and a lot more:

e Rockets e Soil erosion

e Ecology * Explosions

* Bugs and germs ¢ Slime and worms

¢ Plants and animals ¢ Dinosaurs

* Airplanes and helicopters * Computers

* Brains * Machines

* Thoughts and dreams * Numbers and math
e Nurses and doctors e (Climate and weather
¢ Planets and stars ¢ Rocks and minerals
* Strange sounds * Waves and vibrations
* Movie monsters ¢ Video games

But above all, science is the real magic in our world. And science is fun—if
you look at it right. And the most fun way to look at science is from the point
of view of a mad scientist.

What's All That
Other Stuff in the Box?

There are a number of different Exploration tools in the box to play and exper-
iment with. They can be used by themselves, or along with computer widgets.
An explanation of all the tools and toys—and some fun ways to use them—can
be found later in this guide, and in the Widget Activities and Experiments
Book.
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Mow to Become
a Mad Scientist
Without Really Trying

Here are the 25 steps to becoming a first-rate Mad Scientist Level 1. Once you
complete all these tasks, you will have earned your Certificate of Mad
Scientism (on the inside back cover of this guide). You'll be ready to join the
Mad Scientist Hall of Fame, take over the world, and advance to the Widget
Activities and Experiments Book for more fun, more science and more
madness.

Widget Workshop has two main sections: Puzzles and Free Play. In the Puzzles
section, you can load in different puzzle widgets and solve them by fixing or
finishing the widgets. In Free Play you can do or make anything you want:
puzzles, experiments or whatever.

All of the following steps to becoming a mad scientist take place in the Free
Play section. If you follow all the steps, you'll know everything you'll need to
know about Widget Workshop. But if at any time along the way you want to try
some puzzles, go ahead. If you get stuck, come on back.

As you advance through these steps:

Instructions for you to follow will appear in text that looks like this.

Explanations and background information
will appear in text that looks like this.

Good luck! And if you get
stuck, don't get angry—
get mad!
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tep 1. Install and
Start Widget Workshop

The Quick Start Guide in the Widget Workshop box has complete instructions
for installing and starting Widget Workshop on your computer.

Look at the Quick Start Guide now and follow the instructions in the section
called Installation and Starting. Once you've got Widget Workshop up and
running, you'll be ready for Step 2.

$tep 2. Take a Quick Tour
of Your New Laboratory

The first things you see when you start Widget Workshop are the Maxis
Software Toys™ for Kids logo and the Elliott Portwood logo. Next, you'll see the
Widget Workshop title screen. This screen will go away all by itself after a few
seconds, but you can hurry it on its way by clicking your mouse button.

Now vou will be given a number of choices.

Click here to quit

” Click here to solve
Widget Workshop. j

widget puzzles.

=la .
Ta el

L rd
g

Click here to load 3 R :
a widget that you —|IRALSISEE —Click here to create
MEW WIDGET A new wiﬂget.
have already saved. ' A
— o .

Since we haven’t saved any widgets yet, and we don’t want puzzles at the
moment, and we certainly don’t want to quit Widget Workshop, there’s only one
thing to do:

Click on NEW WIDGET.
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Soon you will see your Widget Workshop laboratory.

Menu Bar

Tooltray
Control Box

Work Area

There are four areas in your Widget Workshop:

The Menu Bar is where you access the menus. Your Menu Bar may look a lit-
tle different, depending on your computer.

The Work Area is where you build your widgets.

The Control Box lets you start and stop widgets and control sound and lighting.

Click and drag here to move the

S the scteen GO Click here to make your widget GO!

Click here to make your widget STOP! STOP

Click here to switch the background m _f.l
between light and dark. L

Click here to turn the sound on and off,

Tutor




The Tooltray lets you select the different parts for vour Widgets, and choose
the different tools to move, connect and remove the parts, and to move the
Work Area around.

Click and drag here to move the Tooltray around
the screen. If you point to something with your  Click on these buttons to see the different

mouse, its name will appear here. types of parts.

Click here to acti- The name of the

vate the Pointer widget appears

tool for selecting, here.

placing, moving

and connecting

different parts. Click here to activate Click on these arrows to
the Hand too] to move see more parts.

Click here to activate the Work Area around
the Cut tool, for remov- 5o you can see it all.
ing different parts and

connections. This is the Parts Bin where you

pick up the parts you want.

If you ever need to know what a
part is called, or what a button
does, just point at it with the
mouse, and look at the top of
the Tooltray. You don't even
have to click!
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©Step 3. Your First Widget

The first thing any decent mad scientist needs to know is how to make lights
flash. Widget Workshop lets you flash lights in many different ways. Let’s try
one.

First we’'ll need to pull a couple of parts out of the Parts Bin.

Click on the Display Parts button in the Tooltray. -

Click and drag the Light Bulb out of the Parts Bin into the middle of the 3
Work Area. oy

Click on the Switch Parts button in the Tooltray. [ 18]

Click and drag the Light Switch out of the Parts Bin onto the Work Area,
just to the left of the Light Bulb. ¢
E 5

Now we need to connect the switch to the Light bulb.

&

Move the mouse so it points to the output connector (the little red ball)
on the Light Switch. The pointer will change from this B 10 this. &3

Press the mouse button down and hold it down (if you have more than
one mouse button, use the left one).

Drag the pointer over to the Light Bulb’s input connector (the little red
socket). When the connecting line turns green, release the mouse button.
You've just made an important connection!

et d

Ready to make a con- Put the pointer over Click and drag from The finished
nection. the output connector. the output connector connection.
on the switch to the
input connector on
the Light Bulb. When
the line turns green,

release the mouse
g Tutor




Now let’s try out your widget.
Click on the GO button in the Control Box.
Click on the Light Switch to turn the light on.
Click on the Light Switch again to turn the light off.
Click on the STOP button in the Control Box. LA

That was simple. Now let's try
something else.

Did you notice that the
Tooltray disappears when
you click GO and comes back
when you click STOP?

Htep 4. One More Time—
But Put Your Heart Into It!

Anyone can turn a light on and off with a light switch. A mad scientist (that's
you) can turn lights on and off in all sorts of strange ways. Let's try one.

First, let's get rid of that Light Switch.
Click on the Cut tool button in the THIIrrr.
Click on the Light Switch to make it disappear.
Click on the Pointer tool button.

Now, let's get a fun part to turn the light
on and off—a human heart!

When you cut parts, all
their connections disap-
pear, 100.
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Click on the Super Parts button in the Tooltray. -

Click on the down-pointing red arrow in the lower-right corner of the
Tooltray.

Click and drag the Heart out of the Parts Bin onto the Work Area to the
left of the Light Bulb. .“ G
=

Now connect the Heart to the Light Bulb and turn on the widget.
Move the pointer over the output connector on the Heart.

Click and drag the pointer to the input connector on the Light Bulb.

"X

Look at that light flash. That’s how a real mad scientist turns on a light bulb!

Click on the GO button in the Control Box. K

Click on the STOP button in the Control Box. [EIE

$tep 5. Investigating Parts

Every widget you build is made out of parts. What do we know about parts so far?

e We know that there are different kinds of parts, like switches and dis-
plays.

e We know that we can see different kinds of parts by clicking on the
Parts buttons in the Tooltray.

e We know how to get parts out of the Parts Bins.
e We know how to get rid of parts when we're done with them.
* We know how to connect parts.

e We know that some parts have output connectors and some have input
connectors.

That’s a good start. Now let's take a closer look at parts.
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If you just finished Step 4, then you should still have one Heart and one Light
Bulb in your Work Area, and already have a head start. If vou don’t have any-
thing in your Work Area, then get a Heart and a Light Bulb and connect them
together in the middle of the Work Area just like you did in Step 4.

Now let's look into the matter of the Heart more closely.

Double-click (click twice in @ row, quickly) on the Heart.

When you double-click on any part, an information box will open. Let’s look
closely at the Heart's information box.

Here is the name of the part.

Here is a picture of the

part showing the part's This is an explanation

of what the part does,

Hearts pump bleod through arvimals”’

inputs and outputs. Bodies, Hesrts ST ' shape, 516,
| EpRRO W DUTE TG STy depandineg
oh B yige of B seimal

Click on Doc (the resi-
dent Mad Scientist) for
construction tips that

The bottom section of __
this window has settings

and controls that let you e eart Weight (Ibs.) will help you use the
change what the part : il E"“"""' T e
does. Some parts have '
IO SF SpERa oot Click here to close this infor-  Click here to accept any changes
don’t have any. mation window without keep-  you have made and close this

ing any changes you may information window.

have made.

Click on the Cancel button to close the information box.
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Btep 6. Heart Attack!—Part 1

Now we'll play with all the different settings and controls for the Heart. Let’s
start by moving some things around.

Move the mouse so the pointer is over the middle of the Heart. A green
rectangle will appear around the Heart.

Click and drag the Heart up dloser to the top of the screen, just below
the Tooltray.

Move the pointer to the middle of the Light Bulb.

Click and drag the Light Bulb closer to the top of the screen to the right
of the Heart.

Did you notice that you can move parts around and the connections stay con-
nected? Good. Now we need more parts.

Get two more Hearts out of the Parts Bin.

Get two more Light Bulbs out of the Parts Bin.
Now you should have 3 Hearts and 3 Light Bulbs in the Work Area.

Use the mouse to arrange the parts and connect them so they look like this:
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Now we’ll open the information window for each of the Hearts, one by one, and
change the controls.

Double-click on the Heart nearest the top of the screen.
Click and hold on the words “Human Adult.” W

Tortoise
Elephant
Catl

Dog
Gerbil

Slide the pointer down to the word “Gerbil.” [Ziumen noun

Human Infani
Rabhit
Tortolse

Elephant
Cal

Release the mouse button, then click “
on the OK button.

Congratulations! You just changed a human adult heart into a gerbil heart!

A gerbil is a small
rodent about the same
size as a hamster.

Leave the middle heart alone so it will stay a human adult heart, but change
the bottom heart into a tortoise heart:

Double-click on the bottom Heart to open its information window.

Click and hold on the words “Human Adult,” and slide the | juman infont
Habbit
pointer down to the word “Tortoise.”

Elephani
Cat

Release the mouse button, then click on the OK button. i

Now your three-hearted widget is ready to run.

Click on the GO button in the Control Box.
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The three hearts will beat away at three different rates. When you've seen
enough:

Click on the STOP button in the Control Box.

$tep 7. Heart Attack!—Part 2

We know that we can change the heart part into different kinds of hearts, and
we know how to use a heart’s beat as a switch—but is there anything else we
can do with a heart? You bet there is.

Double-click on a Heart to open its information window.

Look at the part of the information window where it says “Output.” There are
three choices there: Heart Beat, Pulse Rate and Heart Weight. So far we've
only used Heart Beat. Let's try the other two types of outputs.

First we need to get rid of a few parts.

e TP T ———

Click on the Cut tool in the Tooltray.
Click on one of the Hearts and all three of the Light Bulbs.

Now we need to get a couple of new parts and hook them to the two hearts:

Click on the Pointer tool.

Click on the Display Parts button, then click on the red down-arrow on
the right side of the Tooltray.

Click and drag two of the Three-Digit Displays from the Parts Bin to the

e
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Connect each Heart to a Three-Digit Display.

Now we'll change the outputs of the hearts:

¢
Double-click on the top Heart. .H’-

Set “Whose Heart” to Rabbit,

Click on the words “Pulse Rate.” The bottom of the information window
should look like this:

Click OK.

Double-click on the bottom heart.
Set the “Whose Heart” to Elephant.

Click on the words “Heart Weight (Ibs.).” The bottom of the information
window should look like this: -

Click OK.

Now let’s make this widget go.

Click on the GO button in the Control Box.

The display hooked to the top heart—the one set to give a rabbit’s pulse rate—
displays the number 60. This shows that a rabbit's heart beats 60 times per
minute. The display hooked to the bottom heart—the one set to give an ele-
phant’s heart weight—displays the number 44. This shows that an elephant’s
heart weighs 44 pounds.

Click on the STOP button when you're done.

A heart that weighs 44
pounds? Is this what people
mean when they say they
have a heavy heart?
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We adjusted the heart to do some very different things. When it was set to
Heart Beat, it acted like a switch and its output was a lot of “ONs” and “OFFs.”
When it was set to Heart Rate and Heart Weight, its outputs were numbers.
This is confusing for even an experienced mad scientist, so we’'ll take a
moment and investigate the most important thing in science: data.

©tep 8. Dig That Data

We've already hooked parts together. We hooked outputs to inputs. But what
is it that travels from an output, through the connection, to an input? It's
data. But what's data?

Data is information. There are many types of information, and all sorts of data.

Widget Workshop has three different types of data that travel through con-
nections:

e On/Off data, also called digital data because on and off is like 1 and 0
(it’s also called Boolean data).

e Number data—either variable (changing) numbers or constant (non-
changing) numbers.

e Sound data—recorded sounds that can be played through a speaker.

Widget Workshop also makes use of two other kinds of data: words and pic-
tures. It can display words and pictures on the screen, but they don’t travel
through the connectors.

One thing Widget Workshop does that you can’t do anywhere else is connect
different data types to each other. You can hook any output to any input and
something will happen. We'll try this later, in Step 24.

In a real laboratory, hooking up different kinds of things to each other can
cause problems—sometimes big problems, like broken equipment, or even
explosions. But in Widget Workshop, nothing will explode, no matter what you
do. But that shouldn’t stop you from trying!

We've already experimented a little with on/off data using switches and hearts.
In the next few steps we’ll experiment with all the other types of data.
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©tep 9. Number Crunching—Part 1

One way to use numbers and numerical data in Widget Workshop is to build
custom calculators. Let’s build a calculator that figures out how many seconds
there are in an hour, a day, a week and a year. We'll build the calculator in dif-
ferent steps, starting with figuring out how many seconds there are in an
hour, then add more parts to figure out the seconds in a day, week and year.

First, we'll need to clean up the laboratory to make room to work. If vour
Work Area is empty, skip these next instructions and jump ahead. If your Work
Area has parts in it, then:

Move the mouse pointer to the Menu Bar at the top of the screen and
point to the word “Edit.”

Click ond hold the mouse button to open the Edit menv.

Slide the pointer down until the words “Clear Work Area” are high-
lighted.

Release the mouse button.

Now we're ready to go. But before we begin building, let's think about the
problem we want to solve. What we want to know is how many seconds there
are in an hour, What we already know is that there are 60 seconds in a minute
and there are 60 minutes in an hour. So the formula we'll need is:

seconds minutes seconds

minutes * 060 hour the number of hour
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Now we're ready to build our calculator. Looking at our formula, we'll need
these parts:

e One number to represent 60 seconds/minute

* Another number to represent 60 minutes/hour

e A Multiplier

e A display to show the answer in seconds per hour

Click on the Number Parts button. -

Click on the red down-arrow.

Click and drag one Multiplier from the Parts Bin to the Work Area. a‘
Click on the red up-arrow until you can see the Mini Three-Digit Number

por. W

Drag two Mini Three-Digit Numbers from the Parts Bin to the work area.

Double-click on one of the Mini Three-Digit Numbers to open its infor-
mation window.

Click in the place where it says “Enter Beginning N

Set the other Mini Three-Digit Number to have 60 as its beginning number.
Click on the Display Parts button. -

Click on the red down-arrow.

Click and drag o Ten-Digit Display from the Parts Bin to the Work Area.
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Now, we'll build our first calculator.

Arrange the parts on your screen so they look sort of like this:

- =

Qur custom calculator is ready to run. Before you start it, look at it for a sec-
ond or two. Doesn't it look just like the formula?

Now let's make it go.
Building a custom calculator is
like building a mathematical
formula.

Click on the GO button and
watch it calculate.

Click on the STOP button.

That's pretty good, but if you were looking at this for the first time, would you
know what it was? Let's put a name on our calculator.

Click on the Text Parts button in the Tooltray. -
Click and drag o Label part from the Parts Bin to just above the calculator.
Double-click on the Label part.

Click the circle to the left of the words “Large Letters” to make the
name nice and big.

Type “SUPER SECOND CALCULATOR.”
nllh u!. Sk

idget Workshop



Get three more Label parts from the Parts Bin.
Double-click on one of the new Labels.

Type “sec/min.”

Click OK.

Set another Label to say, “min/hr.”

Set the last Label to say, “Seconds per hour.”

Arrange the labels to look like this:
SUPER SECOND CALCULATOR

sBC/min i hiur

L

We'll be adding to and expanding our calculator step-by-step, and we won't
want to have to start all over again, so let's save it to disk. That way we can
pick up where we left off without wasting any time or energy.

tep 10. Saving a Widget to Disk

You probably won't want to save every widget you make, but when you make
something you like or if you have to stop in the middle, then saving widgets
will save you time.

Saving a widget to disk is easy:

Move the mouse pointer to the Menu Bar at top of the screen and point
to the word “File.”

Click and hold the mouse button to open the File menu.
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Slide the pointer down until the word “Save” is highlighted.
Release the mouse button.

A dialog box will open that will let you name your widget and choose the disk
and folder or directory where you want to save it. The way the Save dialog box
looks and works is a little bit different on each type of computer. A complete
description of the Save dialog box for your computer can be found in the
Widget Workshop Addendum.

' But for now, you can save your widget this way:

Type “SECONDS1”

Click on the Save button.
This is how the Save
dialog box looks on a
Macintosh. (It may
look a little different
on your computer.)

©tep 11. Loading a Widget From Disk

Now that we've learned how to save a widget, let's learn how to load it back in.
First, make sure that you saved your widget, SECONDS]I, to disk (Step 10).

Now clear the Work Area:

Open the Edit menu and select Clear Work Area.
Now load in the saved version of SECONDSI1:

Open the File menu and select Open....

When the Open dialog box appears, click on the name of the widget you
want to load (SECONDS1).
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Click on the Open button. This is how the Open
dialog box looks on a
Macintosh. It may look
a little different on

your computer.

Simple! You can get more details on the Open dialog box for your computer in
the Widget Workshop Quick Start Guide. Now let’s add more functions to our
calculator.

Step 12. Number Crunching—Part 2

Now let's expand our calculator to figure out the number of seconds in a day.

Our existing calculator tells us how many seconds there are in an hour and we
know that there are 24 hours in a day, so our new formula becomes:

seconds minutes hours seconds
minute X 00 howr X 24 "qay T the number of day

Get another Mini Three-Digit Number and another Multiplier from the
Tooltray.

Set the new Mini Three-Digit Number so its beginning number is 24.

Arrange all the parts on the screen, connect them and add labels so they
look like this:

You can use the Cut tool to remove
connections, but be sure to change
back to the Pointer tool before you
try to make new connections or
you'll delete parts by accident!

SUPER SECOND CALCULATOR
mimin PRt LT

L1} -'H-' Fom
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Well, we have our seconds per day, but we lost our seconds per hour. This is a
job for a splitter—and another Ten-Digit Display.

Get a Two-way Splitter from the Tooltray. (It's under Switch Parts.) :lt
Get a Ten-Digit Display from the Tooltray. (It's under Display Parts).

Rearrange, reconnect and label your calculator to look like this:

SUPER SECOND CALCULATOR

Try it out to see how it works, then save the modified calculator to disk under
another name:

Open the File menv and select Save As....
Type in the name “SECONDS2.”
Click on the Save button.

Now we'll expand the calculator again, this time to also calculate the number
of seconds in a week.

Our calculator already tells us how many seconds there are in a day, and we
know that there are 7 days in a week, so our new formula is:

seconds minutes hours da seconds
60 ity X B 24 day X7 ;Hﬁk = the number of ik
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Get a Ten-Digit Display, a Multiplier, a 2-Way Splitter and o Mini Three-
Digit Number from the Tooltray.

Set the Mini Three-Digit Number so its beginning number is 7.

Rearrange, reconnect and label your calculator to look like this:

Test it out and see how it works, then:

Save the widget to disk as “SECONDS3.”

Step 13. Getting Fancy

You probably noticed that the more parts there are in a widget, the longer it
takes to arrange everything to fit on the screen and to make the connections.

Here are a few things to think about while building a widget:

1. Arrange it so it is easy to understand. That's why the calculator sam-
ples have been arranged in the order that the calculations are made.

2. Arrange widgets so they are hard to understand if you are making a
tricky puzzle.
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3. Add labels, titles and instructions. A widget makes much more sense
with titles and labels. And numbers in a formula don't mean as much
without labels. If you see the number 327 without a label, it could be
327 inches, 327 pounds, 327 ounces or 327 elephant toes.

4. Make it look cool. Why not? You might as well have fun and make
things look good enough to impress your friends and family.

5. Route the connections so they are easy to follow.
Route connections? How?

You can click on the green connection lines to place a blue square, called a
joint, on the connection. Then you can drag the joint around to reshape the
connection line.

To get rid of a joint, move the cursor
over it to highlight it, then hit the
Delete key on vour keyboard, or click
on it with the Cut tool. Be sure only
the joint is highlighted, or the whole
connection will be deleted.

A joint is like an elbow—it
lets connections bend and
reach around parts.

If it’s not already loaded from the last step, load in SEC-
ONDS3, and route the connections so they look something
like this:

SUPER SECOND CALCULATOR
gec/min  minfhour  hresdeg b W

el
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Save your newly routed widget under the same name:

Open the File menu and select Save.

Take some time and play with making, adjusting and deleting joints.

©tep 14. Number Crunching—Part 3

Now we l] add the final stage to our calculator: the number of seconds in a
year.

Our calculator already tells us how many seconds there are in a week, and we
know that there are 52 weeks in a year, 50 our new formula is:

seconds minutes hours ﬂ.i}rs weehs seconds
60 Linute X % Thowr * ¥ day * 7 week * 52 yaur year = the number of year
Get the extra parts you need from the Tooltray and expand your calcu-
lator to look something like this:
SUPER SECOND CALCULATOR
- -! -T -
| SOCOMN [ e | SO an pET ek |
—! — |
Be sure to set the new Three- B
Digit Number to 52. 3.1450€+077 What does that

mean’ Did | do something wrang?
Is this widget broken? For the

thrilling answers to all these ques-
tions, stay tuned to Step 15!

Try out the finished calcula- A\

tor, then save it under the
name SECONDSA4.

Tutor
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$tep 15. Scientific Notation

Scientific notation is an easy shortcut way to write and talk about really big
and really small numbers.

What if someone asked you what number these numbers were?
96840000000000000000000000000000000000000
.00000000000000000000000000000000000009684

They would be hard to say and hard to think about because of the number of
digits. You'd have to count all those zeros and remember how many zeros are
in a million, a billion, a trillion and a googol.

These same numbers in scientific notation would be written like this:
9.684 x 10*
9.684 x 10

and pronounced like this:
Nine point six eight four times ten to the thirty-ninth
Nine point six eight four times ten to the minus thirty-eighth

Scientific notation makes it easy to talk and think about big and small num-
bers by dividing them into 2 parts:

6.023 x 10%
" e,

The Mantissa—a number with The Exponent—a multiplier to
one digit, a decimal point and move the decimal point.
possibly more digits.

To turn a number into scientific notation, follow these steps:

1. Put a decimal point between the first digit that isn't zero and the sec-
ond digit.

2. Write the number with the new decimal point, and without all the
zeros (the mantissa).
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3. Count the number of places from the original decimal point to the new
one.

4. After the mantissa, write “x 10" and make the number of places you
counted the exponent for the 10, If you moved the decimal to the left,
then put a “+” or nothing before the exponent. If you moved the deci-
mal to the right, then put a “-” before the exponent.

Here's how to do it with a big number: 123000000
1. 123000000 changes to 1.23000000
2. Rewrite it without the zeros: 1.23

3. Count the number of places the decimal moved: 0, 0, 0, 0, 0, 0, 3, 2—
that's 8 places to the left.

4, 1.23 x 10* or 1.23 x 10*

Here's how to do it with a small number: .0000567
1. .0000567 changes to 00005.67
2. Rewrite it without the zeros: 5.67

3. Count the number of places the decimal moved: 0, 0, 0, 0, 5—that’s 5
places to the right.

4. 5.67x10*

To change a number back from scientific notation, follow these steps:
1. Look at the exponent.

2. If it is positive (has a “+” or nothing in front of it) then move the dec-
imal point to the right the exponent number of places (if the exponent
is 6, move the decimal point 6 places), and add zeros to fill in the
spaces. If it is negative (has a “-" in front of it) then move the decimal
point to the left the exponent number of places (if the exponent is 6,
move the decimal point 6 places), and add zeros to fill in the space.
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Here's how to do it with a big number: 4.3 x 10
1. The exponent is a positive 9.

2. Move the decimal point 9 spaces to the right and add in zeros to fill the
spaces: 4.3 becomes 4300000000,

Here's how to do it with a small number: 7.6 x 107
1. The exponent is a negative 7.

2. Move the decimal point 7 spaces to the left and add in zeros to fill the
spaces: 7.6 becomes .00000076.

But what'’s that E thing in the Seconds Per Year of the second calculator?

Digital displays like these can't display the small numbers you need to show
exponents. 5o instead, they display the letter E to let vou know that the next
number is an exponent, then a “+" or “-" and then the actual exponent.

So, when you see E-7 it means 107. And when vou see E+22 it means 102, And
when you see...I think you get the idea.

$tep 16. What Are Random Numbers?

Sometimes you need a little uncertainty in your widgets, and using random
numbers is the way to do it.
The two most common ways we use random numbers in our daily lives are:

1. Rolling Dice: with one die, each roll randomly picks a number between
1 and 6; with two dice, each roll randomly picks a number between 2
and 12, and so on and so on and on and on.

2. Tossing a Coin: this is just like rolling a two-sided die—the choices are
heads and tails and not two numbers, but it works the same way.

Random numbers are used a lot in computer games to add surprises and to
make it harder for the player to predict what is going to happen next.
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Widget Workshop has two parts that generate random numbers:

1. The Random Number Generator picks numbers randomly from a range
that you can set.

2. The Coin Toss tosses a coin and outputs a 1 for heads and a 0 for tails.

There is a whole branch of mathematics that deals with random numbers: the
laws of probability. We'll come back to that later.

$tep 17. Designing a Number
Guessing Game—Part 1

The next few steps will aid you in a couple of ways as you follow your quest to
become a mad scientist:

1. You will have fun with random numbers.
2. You will learn how to design your own widgets.

Now we'll make a number guessing game. Just like we did with our second cal-
culator, we'll start simple, and build it up in steps. Here's how the simplest
version of the game will work:

1. The widget and the player each pick a number between 1 and 10.

2. If the guess is right, the player wins.

3. If the guess is wrong, the widget will tell the player to guess again.

It's very simple to build a widget for this game, but since we'll be getting more

complicated later, we'll think it through step-by-step, and make a flowchart to
help us design it.

Flowcharts are like maps,
but instead of showing
where things are, they show
what happens when.
They're like time maps.
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In this flowchart, we show all the steps Guassing Game 1 Fiow Chart

that we want our number guessing S

game widget to follow. The flowchart is S
made of boxes and arrows. Each box is ——
one step. Inside each box is a descrip- HE'"“::ELT
tion of the step, and the Widget pLT
Workshop part that is needed for the . .
Py gosases 4
5tED, g MY Bt | nd
Ihhl_'l:r:':mﬂf
See if you can follow the flowchart I Rl S
through all the steps. You can even play A | sl s 4
" E : o WomSS T e e Wt i play g I—
the guessing game with a friend while N e s |
following the steps—you can be the \:f Ve
widget and your friend can be the play- o — :
er. ﬂ;_ﬂ\ -l'mn'r:-ﬂ:uql
S e
Now let’s build our widget. Here's the | ey ot i '
parts list: L
e ] Keypress e 2 Two-way Splitters

* ] Random Number Generator ® 2 Comparers (one set to =, one set to #)
® 1 Numeric Keypad e 2 Billboards (One with a “win” message,
one with a “lose” message)
Get the parts from the list above out of the Tooltray and build the
Number Guessing Game to look like this:

NUMBER GUESSING GAME

Be sure to double-click on both of
the billboards and type in the new
messages. And don't forget to set
one of the Comparers to =, and
the other one to =!

¥ou're right] Press “R°
) on your keyboard te
A sy again.
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Try out the game.
Save the widget to disk. Call it GUESSER].

It's a pretty simple game, but how do we know if it really works? Let’s put a
temporary modification in there to help us test it: a display to tell us what the
random number is. Once we play this as a game, we’'ll take it out, but for now
it'll help us test the game.

Get a Three-way Splitter and a Three-Digit Display.

Delete or cut the Two-way Splitter that is hooked to the Random
Number Generator.

Put the Number Guessing Game together to look like this:

NUMBER GUESSING GAME

Foure right] Fress “A°

plsy sgain.

Run it to test the game.

The words in the Billboards won't
all appear at once—they're just dis-
played here to show you what to

type in.

Save the widget to disk. Call it
GUESSER2.

Not bad. But we can make it better.
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$tep 18. Designing a Number
Guessing Game—Part 2

Now we'll add all these features to our
; Guassing Game 1 [ow Chart
Guessing Game: et
1. Give the plaver hints: tell them oy o TSN
if their guess is too high or too i ’“ﬁ_.; /
low. ——— st
2. Play a clapping sound for a e
ight guess | Twm
ri .
E - H"*--. e Lty f;h.-:-ppq 5
3. Play a buzzer sound for a wrong : {Hxl-"f.‘-"'-";}--- = |.......£:;
guess. 1 e
Here's the flowchart for the new ver- Pl T L~
: . e fm—— Dt —
sion of the Guessing Game. ; ..
7 &/
Computer programmers use flow- bt
charts. And the instructions list
looks just like a computer program.
In fact, building a widget on a
computer is actually one way to
program the computer!
Build the guessing game. It will
look like this:
NUNDER GUESSING GAME You will have to delete some parts,
Press Aot - add others, and adjust many of the
+ settings.
Run the widget to test the game.

When it works, remove the test
display.

Save the widget to disk. Call it
GUESSER3.

Did you notice that blue thing with the word “OR" on it? That’s a type of Logic Gate.
You'll learn all about them in Step 21, but see if you can figure out what it’s doing.
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$tep 19. Designing a Number
Guessing Game—Part 3

You're on your own now! See if you can modify the Guesser to have these extra
features:

* Have a dog bark when the guess is too low.
e Have a cat meow when the guess is too high.

¢ Replace the input keyboard key with a Metronome set to 2 beats per
minute—that gives the player 30 seconds to guess each number.

Try making a flowchart for the new version of the game before you start to
build it.

After you build it, save it as GUESSERA4.

tep 20. Making a Stand-Alone Widget

One of coolest things about Widget Workshop is that it lets you turn your
inventions, games, puzzles or other widgets into stand-alone computer pro-
grams. This means that vou can run your widgets on any computer (as long as
it's the same kind as vours, or very close) even if that computer doesn’t have
Widget Workshop. And that means you can share your widgets with friends at
their homes or at school. Let's turn GUESSER3J into a stand-alone game:

Load GUESSERS3 into Widget Workshop.
Open the File menu and select Save
Warning! Stand-Alone Widgets Into @ Stand-Alone mdg“'

may be too big for a disk—you
may need to compress the Widget

file to make it fit. When the dialog box opens, type in

this name: GuesGame, then click on
the Sove button.

Now you can put it on a floppy disk and take it to school or
a friend’s house.
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$tep 21. Logic Gates

Logic gates are very important to mad scientists—and the other kind, too.
They are the basic building blocks of computers.

Remember the blue logic gate with the word
“OR" on it back in Step 187 Did you figure out
what it was doing!

Logic gates work with digital data. They only understand 1 and 0, YES and NO,
TRUE and FALSE, or ON and OFF. Some gates have one input, some have two
inputs, and some have more. All gates have one output. For our purposes,
we'll call the inputs A and B.

Widget Workshop has four different types of logic gates. Here's an explanation
of what they do:

Gate Name | # of Inputs Output

AND Gate 2 (A, B) If A and B are 1 (ON), then the Output will be
1 (ON). Otherwise the output is 0 (OFF).

OR Gate 2 (A B) It A or B or both are 1 (ON) then the Output
will be 1 (ON). Otherwise it will be 0 (OFF).

XOR Gat If A or B—but not both—are 1 then the

[E:r.hilv: OR)| 2 (A, B) o.n:mnhT'm Mm will be 0
(OFF).

NOT Gate If Ais 1 (ON), then the output will be 0 (OFF).

(Inverter) 1 (A) If A is O (OFF) then the output will be 1 (ON).
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The easiest way to understand what logic gates do is with truth tables. A truth
table shows all of the logic gate's possible combinations of inputs and the
resulting outputs. Here are truth tables for the four gates in Widget
Workshop:

- 5o E

AND Gate OR Gate XOR Gate

A B Output A B Output A B Output
0 0 0 0 0 0 0 0 0

0 | 0 0 1 1 0 1 1

] 0 0 1 0 1 1 0 1

] ] ] 1 1 1 1 | 0

In these tables we could use YES or TRUE
or ON instead of 1 and NO or FALSE or
OFF instead of 0 and it would mean the
same thing.

Now let’s test these truth tables to see if they're telling the truth.

Build this Truth Table Tester:

TRUTH TABLE TESTER

E.s-»« E,I
& ST &

Start the widget and try
every combination

for the inputs of each logic
gate.

When the light is ON, then the
gate's output is 1 or YES or TRUE.
When the light is OFF, then the
output is 0 or NO or FALSE.

Are the truth tables truthful? Tutor




©tep 22. Testing the Laws of Probability

Let's build a probability tester. Back in Step 16, we mentioned the laws of
probability. These laws tell us how likely (or how probable) something is to
happen. They have a lot to do with random numbers.

According to the laws of probability, if you flip a coin, there is an equal chance
(50-50) that the result will be either heads or tails. If you flip a coin 100 times,
it should, according to the laws of probability, come up close to 50 heads and
50 tails. The odds (another way to say laws of probability) are that:

50 times out of 100 it will be heads, and
50 times out of 100 it will be tails.

We won't explain the laws of proba-
bility right now (ask one of your
parents during dinner or your
teacher during math class), but we
can build a widget to test the laws to see if we think they're
right.

Of course, the laws of
probability don’t work
with trick coins!

Here's a flowchart for our Probability Tester:

Probabiity Tester Flow Chart

i S g

L (Checkoos OO ,-I

1 l'lpi-uir-
e 1 0 Bl
44 ﬂ‘:'-. . = I:“THI':“I'

¢¢

Add pos k= e
ey oo
]

il o o e
Ty COnpigr
{Totmbarh
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Build the Probability Tester:

PROBABILITY TESTER

Press "A” Lo

Taotal coin Mips

Save it to disk. Name it Probl.

Run the widget and press the key 100 times to make 100 coin tosses.

Did the laws of probability hold up?

Here are some ways to fix up the

probability tester if you can:

e Put a Splitter and a Light
Bulb at the input of each
Totaler to show whether
the toss is a heads (1, light
on) or tails (0, light off).

* Make a different sound play for heads and for tails.

You probably won't come
up with exactly 25, 25 and
50, but you should be
pretty close.

* Trigger the Coin Tossers with a metronome set to 2 beats per minute
and use Win/Lose Checker to stop the widget after 1,000 tosses.

* Divide the Totaler outputs by the total number of coin tosses, then
multiply them by 100 to calculate the percentages of the different out-
comes.
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$tep 23. Mixing Colors

You probably learned about primary and secondary colors in school. Red, vel-
low and blue are the primary colors. You can mix them together in different
amounts to get all the other colors.

In Widget Workshop, we deal with mixing colors in a slightly different way—
the way your computer does. A color monitor (your computer screen) makes
colors on the screen by mixing different amounts of red, green and blue—
that’s why color monitors are sometimes called RGB monitors (for red, green

and blue).

Widget Workshop comes with a Color Mixer that's just like a giant pixel. (A
pixel is a single dot on a computer screen. Look closely at your screen...can
you see that everything is made of tiny dots?) It has three inputs, one each for
red, green and blue.

The input range for each input is from 0 to 100. The higher the number that
you hook to an input, the more of that color is displayed. There is an excep-
tion to this rule: If you hook a part with a digital output (1/0, YES/NO,
ON/OFF, TRUE/FALSE) to a Color Mixer input, a “1” or “ON" will turn that
input all the way on, just as if vou had connected the number 100.

We'll try a couple of different experiments with the Color Mixer. First, we'll try
to find the right mixtures to make a few special colors, then we’ll see if we can
make the Color Mixer continuously change colors.

Build this widget: .
Save it to disk as Color1. .
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Change the numbers to fill in the rest of this chart. On some you'll have
to find the red, green and blue values to moke each of these colors. On
others you’ll have to input the numbers and name the color.

Color Red Green Blue
| Black 0 0 0
White i 209 e Remember: only the values
Light Gray from 0 to 100 affect the
Medium Gray 50 | 50 | 50 B i
Dark Gray as 100.
50 0 50
90 30 0
90 0 40
100 | 100 0
Lime Green
Chocolate
Sky Blue

Now let’s build a widget that'll really put the Color Mixer through its paces—
a Random Color Generator:

Build this widget: RANDOM COLOR GENERATOR

)
=
‘e
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Set the Number Range on all three Random Number Generators to 1-
100.

Save it to disk as Color2:

Try it out.

Try to make different color changers by replacing one or all of the Random
Number Generators with other parts that have changing numbers. Here are a
few possibilities:

Sliders, Counters hooked up to metronomes at different speeds, Stop Watches
run through Multipliers and Dividers and set to reset when they go above 100,

©tep 24. Mixed-Up Data Types

As you must have realized by now, you can do things in Widget Workshop that
you can't do in the “real world.” One of those things is connecting different
data types. Widget Workshop lets you hook any output to any input, and some-
thing will happen—not necessarily what you wanted to happen, but something
will happen.

Here's a review of the different data types:

*  On/Off data, also called digital or Boolean data, consists of On/Off, 1/0,
YES/NO, or TRUE/FALSE.

¢ Number data can be either changing numbers or constant (not chang-
ing) numbers.

¢ Sound data is recorded sounds.
e Text data is words and labels.

e Picture, or graphic data is pictures
and drawings.

Remember, only the first three data
types can travel through widget
connections. Text data and picture
data can be displayed on the
screen, but not sent through con-
nections.
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Here's a chart of what happens when you mix data types:

Mixing Data Types
Onwi Ci=d N\:ir
Dot i B i Duita 4 Hmizaar s |
(On/OR, 170, YESMO, TRUE! | ] {Poite and ragatie rdege
FALIE] (= O Ciharaiss = On R T Y
J I
i”rl | | o
ER i — Mo Sound =
| |
Sionsal preian = O N Somarad,
m-mm bumear = Pach !
| |
=y o b |
r 'H\ -.-..-
Sound Data |
(DN # 35Und W] |

Now let’s try some data mixing and see what happens. We'll make a widget that
has three data creators: a Mouse Button for On/Off data, a Tuning Fork for
sound data and the Numeric Keypad for number data. We'll hook each of these
three data creators to three types of data receivers: a Light Bulb for On/Off
data, a Three-Digit Display for number data and a Speaker for sound data.

Build this widget: DATA MDER
Start the widget.

Turn on the switch that starts
the Tuning Fork.

Click the Mouse Button.

Enter different positive and

negative numbers into the

Numeric Keypad.

Did you get the data mixing results vou thought vou would?
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$tep 25. Graduation Exercise:
The 21 Dog Salute

This is it! The last step! When you finish this last step:
¢ You'll be a first-rate Mad Scientist Level 1.

* You'll have earned your Certificate of Mad Scientism (on the inside
back cover of this guide).

*  You'll be ready to join the Mad Scientist Hall of Fame.
*  You'll be ready to take over the world (vou're on your own on this one).

* You'll be ready to advance to the Widget Activities and Experiments
Book for more fun, more science and more madness.

For our final experiment, we'll figure out 21 ways to make a dog bark—actu-
ally, vou'll figure out most of them.

Here's a widget with the first three
ways to make a dog bark, to get vou
started. For the next 18, you're on

your own.
21 WAYS TO MAKE A DOG BARK

No animals will be harmed in the
testing of this widget!

5 Shww] barsomly prevs & end e morss bl o

Be creative and try to think up

-" strange and funny ways to
make the dog bark. Use as

many parts as you can.

Print out your funniest, fanciest, most creative
way to make a dog bark and mail it to:

MAXIS Attention: 21 Dog Salute
2 Theatre Square
Orinda, CA 94563




Widget Workshop Reference

Yhe Menus
Apple Menu (Macintosh version only)

About Widget Workshop... brings up a small window that gives important
information about Widget Workshop and lists all the people who helped to cre-
ate it.

File Menu

New starts a brand-new widget. If vou already have a widget on the screen, you
will be given the chance to save it to disk before the new one takes over.

Open... lets you load a widget that has already been saved to disk into Widget
Workshop. If you already have a widget on the screen, you will be given the
chance to save it to disk before another one is opened.

Load Puzzle... opens the Puzzle dialog box so you can pick a puzzle to puzzle
OVET.

Save saves a copy of the widget that is on vour screen to disk. If it hasn't been
saved before, you will be asked to name your widget. If you save a puzzle, it
will turn into a regular widget.

Save As... lets you rename a widget as you save it, and/or save it to a different
disk, folder or directory.

Be sure to save
your widgets to
disk often!
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Revert is a go-back. If you're working on a widget, and decide you like it bet-
ter the old way, choose Revert. Widget Workshop will change the widget to the
way it was the last time you saved it. If you

haven't saved it vet, you can't revert.

Stand-Alone widgets will
only work on the same kind
of computer they were cre-
ated on, so if you have a
Macintosh, it will only work
on Macintoshes, and if you
have Windows, it will only
work on computers with
Windows.

Import a Stand-Alone Widget... lets
yvou load a Stand-Alone Widget into
Widget Workshop to change it. When

you are done changing it, if you want
the fixed-up widget to be a Stand-Alone
Widget, then be sure to choose Save Into
Stand-Alone Widget. If vou just choose Save
or Save As... it will be a regular widget that will
only work on computers with Widget Workshop.

Save Into a Stand-Alone Widget... lets you save a wid-
get as a complete program that will run on your friends’
or yvour school’s computers even if they don’t have
Widget Workshop.

Page Setup... lets you print out your widget. If you can, set your printer to
print the widget sideways (sometimes called Landscape). That way, the whole
widget will fit on one page.

Print... prints out the widget that is currently loaded into Widget Workshop.

Quit ends Widget Workshop. If you are working on a widget and haven't saved
yvour most recent changes, vou will be given the chance to save it to disk
before Widget Workshop quits.

Edit Menu

Undo lets you backtrack one step. For instance, if you delete a part by acci-
dent, you can choose Undo to bring it right back without searching for a new
part in the Tooltray.
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Clear Work Area removes all parts and con-

' ith this one! If
nections from the Work Area. Be careful with this one! If you

choose Clear Work Area by acci-
dent, open the Edit menu and

Remove All Connections deletes all the con- select Undo right away!
nections between all the parts in the Work

Area, but leaves the parts there,

Remove All Joints deletes all the blue
joints from all the connections on the
screen. All the connections and parts
will stay where they are.

Options Menu

This menu lets you decide whether or not to have scroll bars on the screen,
and lets vou choose different backgrounds for Widget Workshop. A checkmark
shows which background has been chosen. Each background will change when
vou click on the Light on/off button in the Control Box.

Plain Background chooses a plain white background §_

background.

Metal Waves chooses a light-colored wavy metal background .
colored wavy metal background. [_

Noise chooses a light speckled background m or a dark speckled back-
ground.

Steel chooses a metallic (corrugated steel) background % or a dark metal-

lic background.

Refere




s e o oo o o o g

Help Menu (Windows version only)

About Widget Workshop... brings up a small window that gives important

information about Widget Workshop and lists all the people who helped to cre-
ate it.

Help Contents opens the Windows on-screen help system to the table of con-
tents, so you can easily look up anvthing vou want to know.

The Off-Computer Exploration Tools

Widget Workshop comes with a number of things that you can experiment
with off the computer and combine with on-computer widgets:

¢ A Spinning Top

+ A Thermometer

« A Magnifier

* A Compass

« Some Rubber Bands

+« Some Straws

A number of sample experiments using these Exploration tools are included in
the Widget Workshop Experiment and Activity Book.

Puzzles

Widget Workshop comes with a number of fun puzzles to solve. By the time
you figure them all out, you'll know all about most of Widget Workshop's parts
and features.

Puzzles are special widgets. You solve them by adding parts and connections.
Puzzles are just like regular widgets, except for two things:

1. There are some parts and connections that you can't move, delete
or change.

2. You are only allowed to add a certain number of parts to solve them.

You can get to the puzzles in two ways:
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1. When you first start Widget Workshop, click on Load Puzzle in the
opening screen.

2. At any other time while Widget Workshop is running, open the File
menu and select Load Puzzle.

Once a puzzle has been Here is the list of puz-
solved, a red checkmark ales. Click on a puzzle

appears next to its name, sl name to select it.

JLightbulbs
Guess the Nate
ore Lighibuibs
Bec's Diabolical Rdder

Count To Ten!
Barking Dogs

Click here to open a dialog oo e g
box that will let you select S1ill More Lightbulbs
different sets of puadles. T Rt Click here to close the
{Only the one set comes Aetect Puzzie Tl [ Puzale Loader without
with Widget Workshop. [ Meset Completed Puzzies loading a puzzle.

Check local softw
i - Click Bere to load the

dealer or on-line service
for news of additional puz- Click here to remove all checkmarks, selected puzile.

tle sets.)

Once you select Load Puzzle, the Puzzle Loader will appear:

Puzzles have some pieces and connections that are “locked” in place, and can't
be moved or removed. And yvou will have to solve the puzzle with a limited
number of parts.

Once you load a puzzle, vyou can save it to disk, then load it back in as a reg-
ular widget. Once you do this, you can move and delete and change it all you
want and use as many parts as you want to make it a new puzzle or widget. But
if you solve it after you save it and load it back in, it won't be marked as solved
in the Puzzle Loader.
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©pecial Features
About Sound and Recording

The parts that involve sound will only work on computers that support sound.
Sound works a little differently on different computers. Some can play and
record sounds. Some can play sounds but can’t record. Some can’t do either.
See the Widget Workshop Addendum/Quick Start Guide for details on whether
or not you can use the sound parts with your computer.

Sound parts need more computer memory than other parts. Depending on
how much memory your computer has, you may be limited in the number of
parts (like Sound Transformers) that you can use at one time. If you run out
of memory for sound parts, then the icons for those parts will be grayed out
in the Tooltray.

About Stand-Alone Widgets

Widget Workshop lets vou turn your widgets into complete Stand-Alone pro-
grams. This means that you can take these Stand-Alone Widgets and run them
on computers that don't have Widget Workshop.

Stand-Alone Widgets that were created
on a Macintosh with a color screen
will only work on a Macintosh with a
color screen and Stand-Alone Widgets
that were created on a computer running
Windows will only work on another computer
that is running Windows. Be sure that the computer
you play the Stand-Alone Widget on has as much RAM
as the computer you made the Stand-Alone
Widget on—or it might not work.

Some Stand-Alone Widgets
can be too big to fit onto a

floppy disk.
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Work Area Size

The Work Area in Widget Workshop varies on different types of computers. On
many computers, the Work Area is too big for the whole thing to fit on the
screen. You can tell if there is more Work Area than meets the eye by opening
the Options menu and selecting any background except Plain. If you can see
the complete frame around the whole Work Area, then you can see the whole
thing. If the frame doesn't go all the way around, then you can use the Hand
tool B4 in the Tooltray to move the Work Area around so you can see it all.

Widget Troubleshooting

Widgets can be very complicated, and sometimes they don't work the way you
expect or want them to. If you have problems getting yvour widgets to behave,
look through these questions and answers. They may solve vour widget problems.

Why won't the Three-Digit Number or the Numeric
Keypad let me change their numbers?

You can only change these numbers while the widget is running. You can dou-
ble-click on these parts to open their information windows so you can set their
beginning numbers, but you have to click GO in the Control Box and start the
widget before you can change their numbers by clicking on them.

I put parts to make sounds in my widget, but I
don't hear sounds. What's wrong?

First, you can only hear sounds on computers that have support for sound. See
the Widget Workshop Quick Start Guide for information about sound on your
computer.

If your computer can play sounds and you still don’t hear them, then be sure
you hooked up a Speaker to the parts that make sound. You can’t hear sounds
without a Speaker.
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If all else fails, make sure that your sound volume is turned up in the Sound
Control Panel. See the manual that came with your computer or your sound
card for instructions on finding and adjusting the Sound Control Panel.

The Three-Digit Display doesn't display what it
should. What's going on?

The Three-Digit Display only displays whole numbers, from negative 99 to
positive 999. It won't show decimal points. Fractions and decimals will be
rounded off to the nearest whole number. If a number is lower than -99 or big-
ger than 999, a red “X” will appear to let you know something is wrong.

There is a weird number with a letter “E" in it on
the Ten-Digit Display. What happened?

When numbers are too big or too small to be completely displayed in the Ten-
digit display, then the numbers will be converted to scientific notation. The
“E"” stands for exponent. See Step 15 for more information on scientific nota-
tion.

Why is there a red “X" over a part on the screen?
If there is something in your widget that confuses the computer, a red “X” will
appear over the part that is causing the confusion.

Things that confuse the computer include:
+ Trying to use a number that is too big or too small for a part, like
trying to make the Three-Digit Display display four digits, and

« Undefined or invalid mathematical operations, like dividing any
number by zero, Nothing confuses a computer more than trying to
divide a number by zero.

So any time a part gets confused, it will display a red “X,” until the confusion
stops. Sometimes as the widget runs and you adjust numbers the red “X” will
go away by itself, but sometimes you will have to fix your widget.
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Also, if you use the Sound Transformer to change the pitch of a sound, and it
is too high or too low in pitch for the speaker to play, a red “X” will appear
over the Transformer.

Why is a part icon grayed out in the Tooltray?

If lots of part icons are grayed out, then you are probably in puzzle mode. In
puzzle mode, many parts are grayed out and unavailable to make the puzzles
more of a challenge

This also happens when you don’t have enough memory to add any more of
these parts to your widget. Sound parts in particular need a lot of memory to
work, so these are usually the first to go.

I'm building a big widget, and I can't fit all the
parts onto the screen. What do I do?

First, remember that on many computers, there is more room in the Work
Area than shows on the screen. Use the Hand tool to move the Work Area
around so you can use all the corners and edges.

Another way to save space is to overlap parts on the screen. You can put parts
on top of each other and they'll still work—just be sure that all the connec-
tions are right and that the parts you'll need to click on while the widget is
running are on top.

The Mini Three-Digit Number is another good way to save space. It can be
used instead of the (regular) Three-Digit Number as long as you don't need to
change it while the widget is running.
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I click the GO button in the Control Box and
things happen (like the Counter counting 1)
before I'm ready.

Widget parts are eager to start working, and will do their job as soon as they
see an input. For instance, Counters will sometimes register a count or
Totallers will start adding up numbers before vou intend them to start.

Watch for this, because it will happen every so often, and it can confuse your
widget. Here's an example:

39

Here we have the output of a Counter hooked to a Comparer. When the count
reaches five, the Comparer makes the dog bark. If the Counter counts the first
one before you think it should, then the dog will bark at four, not five. There
are two ways to work around this problem:

1. Change the comparing number (the 5 in the Three-Digit Number)
to six. That way, even though the number says six, the dog will bark
after five “real” counts.

2. Add parts to subtract one from the Counter before it goes to the
Comparer, like in this example:

Widgets can be tricky! They
won't always do what you want
or expect them to do right away.
But if you think about it and
keep trying, you can create some
wonderful widgets!
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